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ABSTRACT 

The aim of this program is to develop cabin and container stock in company that contain

registration, all applications and also account application. The program was prepared by

using Delphi programming and using database.

Well Product stock and selling program is important like the program that is used

production. Also production is much more important then others.

This project has as its goal to develop software, processing information about activities of

product application software. Software developed in this project like not only for product

the same time for staff and for owner of the production. All records keep in the other

Database program. It acts easily and fast access. Managers can keep all records in the

program as concentment.
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INTRODUCTION 

Since human created by the powerful Allah, Human wonder everything.Well who tried to

satisfy wonder.Such humanity came to nowadays as develop.Todays everyone says

technology perfect developed.Yes that is right.By means of technology all process gained

velocity.This development acts to spend time to the people.

Technology is entered to every platform of our life human needed to combine both

software and hardware. Without software the machines are nothing. They need software to

operate.The automation is also became a part of our lives. The people operate with

automation systems in everywhere.

Karmod cabin and container stock and selling program which is my project.In this software

managers can keep easly information about products.
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CHAPTER! 

DELPHI 

1.1 INTRODUCTION TO DELPHI 

The name "Delphi" was never a term with which either Olaf Helmer or Norman Dalkey

(the founders of the method) were particular happy. Since many of the early Delphi

studies focused on utilizing the technique to make forecasts of future occurrences, the

name was first applied by some others at Rand as a joke. However, the name stuck. The

resulting image of a priestess, sitting on a stool over a crack in the earth, inhaling sulfur

fumes, and making vague and jumbled statements that could be interpreted in many

different ways, did not exactly inspire confidence in the method.

The straightforward nature of utilizing an iterative survey to gather information

"sounds" so easy to do that many people have done "one" Delphi, but never a second.

Since the name gives no obvious insight into the method and since the number of

unsuccessful Delphi studies probably exceeds the successful ones, there has been a long

history of diverse definitions and opinions about the method. Some of these

misconceptions are expressed in statements such as the following that one finds in the

literature:

It is a method for predicting future events.

It is a method for generating a quick consensus by a group.

It is the use of a survey to collect information.

It is the use of anonymity on the part of the participants.

It is the use of voting to reduce the need for long discussions.

It is a method for quantifying human judgement in a group setting.

Some of these statements are sometimes true; a few (e.g. consensus) are actually

contrary to the purpose of a Delphi. Delphi is a communication structure aimed at

producing detailed critical examination and discussion, not at forcing a quick
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compromise. Certainly quantification is a property, but only to serve the goal of quickly

identifying agr~ement and disagreement in order to focus attention. It is often very

common, even today, for people to come to a view of the Delphi method that reflects a

particular application with which they are familiar. In 1975 Linstone and Turoff

proposed a view of the Delphi method that they felt best summarized both the technique

and its objective:

"Delphi may be characterized as a method for structuring a group communication

process, so that the process is effective in allowing a group of individuals, as a whole, to

deal with complex problems." The essence of Delphi is structuring of the group

communication process. Given that there had been much earlier work on how to

· facilitate and structure face-to-face meetings, the other important distinction was that

Delphi was commonly applied utilizing a paper and pencil communication process

among groups in which the members were dispersed in space and time. Also, Delphis

were commonly applied to groups of a size (30 to 100 individuals) that could not

function well in a face-to-face environment, even if they could find a time when they all

could get together.

I 
Additional opportunity has been added by the introduction of Computer Mediated

Communication Systems (Hiltz and Turoff, 1978; Rice and Associates, 1984; Turoff,

1989; Turoff, 1991). These are computer systems that support group communications in·

either a synchronous (Group Decision Support Systems, Desanctis et. al., 1987) or an

asynchronous manner (Computer Conferencing). Techniques that were developed and
" refined in the evolution of the Delphi Method (e.g. anonymity, voting) have been

incorporated as basic facilities or tools in many of these computer based systems. As a
' result, any of these systems can be used to carry out some form of a Delphi process or

Nominal Group Technique (Delbecq, et. al., 1975).

The result, however, is not merely confusion due to different names to describe the

same things; but a basic lack of knowledge by many people working in these areas as to

what was learned in the studies of the Delphi Method about how to properly employ

these techniques and their impact on the communication process. There seems to be a

great deal of "rediscovery" and repeating of earlier misconceptions and difficulties.
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Given this situation, the primary objective of this chapter is to review the specific

properties and methods employed in the design and execution of Delphi Exercises and

to examine how they may best be translated into a computer based environment.

1.2 WHAT IS DELPHI? 

Delphi is an object oriented, component based, visual, rapid development environment

for event driven Windows applications, based on the Pascal language.

Unlike other popular competing Rapid Application Development (RAD) tools, Delphi

compiles the code you write and produces really tight, natively executable code for the

target platform. In fact the most recent versions of Delphi optimise the compiled code

and the resulting executables are as efficient as those compiled with any other compiler

currently on the market.The term "visual" describes Delphi very well. All of the user

interface development is conducted in a What You See Is What You Get environment

(WYSIWYG), which means you can create polished, user friendly interfaces in a very

short time, or prototype whole applications in a few hours.

Delphi is, in effect, the latest in a long and distinguished line of Pascal compilers (the

previous versions of which went by the name "Turbo Pascal") from the company

formerly known as Borland, now known as Inprise. In common with the Turbo Pascal

compilers that preceded it, Delphi is not just a compiler, but a complete development

environment. Some of the facilities that are included in the "Integrated Development

Environment" (IDE) are listed below:

• A syntax sensitive program file editor

• A rapid optimising compiler

• Built in debugging /tracing facilities

• A visual interface developer

• Syntax sensitive help files

• Database creation and editing tools
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• Image/Icon/Cursor creation I editing tools

• Version Control CASE tools What's more, the development environment itself is

extensible, and there are a number of add ins available to perform functions such as

memory leak detection and profiling.

In short, Delphi includes just about everything you need to write applications that will

run on an Intel platform under Windows, but if your target platform is a Silicon

Graphics running IRIX, or a Sun Spare running SOLARIS, or even a PC running

LINUX, then you will need to look elsewhere for your development tools.

This specialisation on one platform and one operating system, makes Delphi a very

strong tool. The code it generates runs very rapidly, and is very stable, once your own

bugs have been ironed out!

1.3 WHAT KIND OF PROGRAMMING CAN YOU DO WITH DELPHI? 

The simple answer is "more or less anything". Because the code is compiled, it runs

quickly, and is therefore suitable for writing more or less any program that you would

consider a candidate for the Windows operating system.

You probably won't be using it to write embedded systems for washing machines,

toasters or fuel injection systems, but for more or less anything else, it can be used (and

the chances are that probably someone somewhere has!)

Some projects to which Delphi is suited:

• Simple, single user database applications

• Intermediate multi-user database applications

• Large scale multi-tier, multi-user database applications

• Internet applications

• Graphics Applications
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• Multimedia Applications

• Image processing/Image recognition

• Data analysis

• System tools

This is not intended to be an exhaustive list, more an indication of the depth and breadth

of Delphi's applicability. Because it is possible to access any and all of the Windows

API, and because if all else fails, Delphi will allow you to drop a few lines of assembler

code directly into your ordinary Pascal instructions, it is possible to do more or less

anything. Delphi can also be used to write Dynamically Linked Libraries (DLLs) and

can call out to DLLs written in other programming languages without difficulty.

Because Delphi is based on the concept of self contained Components (elements of code

that can be dropped directly on to a form in your application, and exist in object form,

performing their function until they are no longer required), it is possible to build

applications very rapidly. Because Delphi has been available for quite some time, the

number of pre-written components has been increasing to the point that now there is a

component to do more or less anything you can imagine. The job of the programmer has

become one of gluing together appropriate components with code that operates them as

required.

.. 
1.4 VERSIONS ARE THERE AND HOW DO THEY DIFFER? 

Borland (as they were then) has a long tradition in the creation of high speed compilers.

One of their best known products was Turbo Pascal - a tool that many programmers cut

their teeth on. With the rise in importance of the Windows environment, it was only a

matter of time before development tools started to appear that were specific to this new

environment.

In the very beginning, Windows produced SDKs (software development kits) that were

totally non-visual (user interface development was totally separated from the

development of the actual application), and required great patience and some genius to
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get anything working with. Whilst these tools slowly improved, they still required a

really good understanding of the inner workings of Windows.

To a great extent these criticisms were dispatched by the release of Microsoft's Visual

Basic product, which attempted to bring Windows development to the masses. It

achieved this to a great extent too, and remains a popular product today. However,it

suffered from several drawbacks:

1) It wasn't as stable as it might have been

2) It was an interpreted language and hence was slow to run

3) It had as its underlying language BASIC, and most "real" programmers weren't so

keen!

Into this environment arrived the eye opening Delphi I product, and in many ways the

standard for visual development tools for Windows was set. This first version was a 16

bit compiler, and produced executable code that would run on Windows 3.1 and

Windows 3.11. Of course, Microsoft have ensured (up to now) that their 32 bit

operating systems (Win95, Win98, and Win NT) will all run 16 bit applications,

however, many of the features that were introduced in these newer operating systems

are not accessible to the 16 bit applications developed with Delphi I.

Delphi 2 was released quite soon after Delphi I, and in fact included a full distribution

of Delphi I on the same CD. Delphi 2, (and all subsequent versions) have been 32 bit

compilers, producing code that runs exclusively on 32bit Windows platforms. (We

ignore for simplicity the WIN32S DLLs which allow Win 3.lx to run some 32 bit

applications).

Delphi is currently standing at Version 4.0, with a new release (version 5.0) expected

shortly. In its latest version, Delphi has become somewhat feature loaded, and as a

result, we would argue, less stable than the earlier versions. However, in its defence,

Delphi (and Borland products in general) have always been more stable than their

competitors products, and the majority of Delphi 4's glitches are minor and forgivable -
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just don't try and copy/paste a selection of your code, midway through a debugging

session!

The reasons for the version progression include the addition of new components,

improvements in the development environment, the inclusion of more internet related

support and improvements in the documentation. Delphi at version 4 is a very mature

product, and Inprise has always been responsive in developing the product in the

direction that the market requires it to go. Predominantly this means right now, the

inclusion of more and more Internet, Web and CORBA related tools and components - a

trend we are assured continues with the release of version 5.0

For each version of Delphi there are several sub-versions, varying in cost and features,

from the most basic "Developer" version to the most complete (and expensive) "Client

Server" version. The variation in price is substantial, and if you are contemplating a

purchase, you should study the feature list carefully to ensure you are not paying for

features you will never use. Even the most basic "Developer" version contains the vast

majority of the features you are likely to need on a day to day basis. Don't assume that

you will need Client Server, simply because you are intending to write a large database

application - The developer edition is quitcapable ofthis.

1.5 SOME KNOWLEDGE ABOUT DELPHI 

•• Delphi is a Rapid Application Development (RAD) environment. It allows you to drag

and drop components on to a blank canvas to create a program. Delphi will also allow

you to use write console based DOS like programs.

Delphi is based around the Pascal language but is more developed object orientated

derivative. Unlike Visual Basic, Delphi uses punctuation in its basic syntax to make the

program easily readable and to help the compiler sort the code. Although Delphi code is

not case sensitive there is a generally accepted way of writing Delphi code. The main

reason for this is so that any programmer can read your code and easily understand what

you are doing, because they write their code like you write yours.
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For the purposes of this series I will be using Delphi 7. There are more recent versions

available (2005 and 2006) however Delphi 7 should be available inexpensively

compared to the new versions which will set you back a lot of money. Delphi 7 will

more than likely be available in a magazine for free.

1.5.1 Example: Try First Delphi Program 

First thing is first, fire up your copy of Delphi and open the Project> Options menu. To

compile a console application you need to change a setting on the Linker tab called

'Generate console application', check the box and click OK. Now select File > Close

All if anything is already loaded. Then select File > New > Other > Console

Application.

Notice the first line refers to the keyword program. You can rename this to HelloWorld.

You can also remove the commented portion enclosed in curly brackets.

The uses keyword allows you to list all units that you want to use in the program. At the

moment just leave it as it is, SysUtils is all we need.

Your unit should now look like this:

Delphi Code:

program HelloWorld;

{$APPTYPE CONSOLE} •• 

uses

SysUtils;

begin

end.

Now what we have just done is written a program, it currently doesn't do a thing

however. Hit the run button and see the result. Now wasn't that completely worthless.
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Luckily this isn't the end of the article so we'll actually have a worthwhile program at

the end of it. All we need to do is insert some code in the main procedure we have just

made.

Every good programmer's first program was 'Hello World' and you'll be no exception.

All we need to do is use the WriteLn procedure to write 'Hello World!' to the console,

simple.Notice the semicolon at the end of the line, at the end of any statement you need

to add a semicolon. Run the program and see the results ...

Now I don't know about you but I saw hello world flash up and go away in a second, if

you didn't write the program you wouldn't even know what it said. To solve this

problem we need to tell the program to leave the console open until the user is ready to

close it. We can use ReadLn for this which reads the users input from the console.

Delphi Code:

program Hello World;

{$APPTYPE CONSOLE} 

uses

SysUtils;

begin

WriteLn('Hello World!'+ #13#10 + #13#10 +

'Press RETURN to end.. .');

ReadLn;

end.

I have added a few extra things into the 'Hello World' string so the user knows what to

do to end the program as it could be a bit confusing. '# 13#1 O' is to insert a carriage
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return as 13 and 1 O are the ASCII codes for a carriage return followed by a new line

feed. ASCII can be inserted in this way into strings.

1.5.2 Delphi Style 

Coding style, the way you format your code and the way in which you present it on the

page.At the end of the day who cares about my style, I can read it, and Delphi strips all

the spaces out of it and doesn't care ifl indent. Why waste my time?

Neatly present code which conforms to the accepted standards not only makes your

code much easier for you to read and debug but also but any one else who might read

your code to help you, or learn from you can do so with ease. After all which code is

easier to follow, example 1 or 2?

Delphi Code:

II Example 1 

procedure xyz();

var

x,y,z,a:integer;

•• 
begin

x:=l;y:=2;

for z:=x to y do begin

a:=power(z,y);

showmessage(inttostr(a));

end;
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-- ----------~- ····--·---------------

end;

Delphi Code:

II Example 2 

procedure XYZ();

var

X,Y,Z,A: Integer;

begin

X := 1;

y :=2;

for Z := X to Y do

begin

A := Power(Z, Y);

ShowMessage(IntToStr(A));

end; I I for end 

end; II procedure end 

Design patterns are frequently recurring structures and relationships in object-oriented

design. Getting to know them can help you design better, more reusable code and also

help you learn to design more complex systems.

Much of the ground-breaking work on design patterns was presented in the book Design

Patterns: Elements of Reusable Object-Oriented Software by Gamma, Helm, Johnson

and Vlissides. You might also have heard of the authors referred to as "the Gang of

Four". If you haven't read this book before and you're designing objects, it's an excellent
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prımer to help structure your design. To get the most out of these examples, I

recommend reading the book as well.

Another good source of pattern concepts is the book Object Models: Strategies, Patterns

and Applications by Peter Coad. Coad's examples are more business oriented and he

emphasises learning strategies to identify patterns in your own work.

1.6 HOW DELPHI HELPS YOU DEFINE PATTERNS 

Delphi implements a fully object-oriented language with many practical refinements

that simplify development.

The most important class attributes from a pattern perspective are the basic inheritance

of classes; virtual and abstract methods; and use of protected and public scope. These

give you the tools to create patterns that can be reused and extended, and let you isolate

varying functionality from base attributes that are unchanging.

Delphi is a great example of an extensible application, through its component

architecture, IDE interfaces and tool interfaces. These interfaces define many virtual

and abstract constructors and operations.

1.6.1 Delphi Examples of Design Patterns 

l"

I should note from the outset, there may be alternative or better ways to implement

these patterns and I welcome your suggestions on ways to improve the design. The
- ' 

following patterns from the book Design Patterns are discussed and illustrated ın

Delphi to give you a starting point for implementing your own Delphi patterns.

Pattern Name Definition 

Singleton
"Ensure a class has only one instance, and provide a global point

of access to it."

Adapter
"Convert the interface of a class into another interface clients

expect. Adapter lets classes work together that couldn't

12




